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Part #OPN-PSM-SIM 

The Carrier® ChillerVu™ provides full and advanced chiller plant management using an EquipmentBuilder library 

of validated algorithms and strategies that enhance operation. You can apply the algorithms as designed or 
customize them in the EIKON® application. You can also integrate the Carrier® ChillerVu™ with third party 
equipment using open protocols. 

You can select from the following protocols:  

• BACnet MS/TP 

• BACnet ARC156 

• Modbus 

• LonWorks Explicit 

• CCN 

 

 
 

 
 

What is the Carrier® ChillerVu™? 
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Carrier® ChillerVu™ specifications 

 

Driver drv_psm_x-xxx-xxx 

Maximum number of control 
programs* 

999 

Maximum number of 
BACnet objects* 

12000 

Maximum number of third-
party integration points 

using the EIKON® 
application*† 

1000 

* Depends on available memory 
† BACnet third-party integration points are not counted. 

Power 24 Vac ±10%, 50–60 Hz, 24 VA 
26 Vdc ±10%, 10 W 

10/100 BaseT Ethernet Port For communication on the Ethernet at 10 or 100 Mbps, half duplex   
For LAN, BACnet/Ethernet, BACnet/IP, and/or Modbus TCP/IP communications 

BACnet port For BACnet ARC156 communication 

Port S1 5-pin EIA-485 for CCN Network and/or CCN Service Tool connection (9600 and 
38400 baud) 

Port S2 Configurable EIA-485/EIA-232 for third party network connections, including: 

• BACnet MS/TP @ 9600, 19200, 38400, and 76800 baud 

• Modbus (RTU and ASCII modes) @ 9600, 19200, 38400, and 76800 baud 

• LonWorks (requires SLTA-10 adapter) @ 38400 and 76800 baud 

Rnet port The standard control programs that are included with the Carrier® ChillerVu™ 
library do not use communicating sensors or touchscreen devices. 

A custom control program can allow you to connect to the Rnet port. 

• Supports up to 15 wireless and/or ZS sensors, and one Equipment Touch or 
TruVu™ ET Display or OptiPoint™ interface 

• Supplies 12 Vdc/210 mA power to the Rnet at an ambient temperature of 

77°F (25°C) with a 24 Vac nominal power source.  

NOTE  Ambient temperature and power source fluctuations may reduce the 
power supplied by the Rnet port. 

NOTE  If the total power required by the sensors on the Rnet exceeds the power 
supplied by the Rnet port, use an external power source. The Wireless Adapter, 

Equipment Touch, or TruVu™ ET Display or OptiPoint™ interface must be powered 
by an external power source. See the specifications in each device's Installation 
and Start-up Guide to determine the power required. 

Rnet Local Access port For system start-up and troubleshooting 

Xnet Remote Expansion For communication with Automated Logic® MEx or Carrier MPC Open XPIO 

expanders  
Up to 6 expanders with a maximum of 144 points between the Carrier® 
ChillerVu™ and the expanders 
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Microprocessor 32-bit Motorola Power PC microprocessor with cache memory, Fast Ethernet 
controller, high performance 32-bit communication co-processor, ARCNET 
communication co-processor, and I/O expansion CAN co-processor 

Memory 16 MB non-volatile battery-backed RAM (with 12 MB available for use), 8 MB 
Flash memory, 32-bit memory bus 

Real-time clock Battery-backed real-time clock keeps track of time in event of power failure 

Battery 10-year Lithium CR123A battery retains the following data for a maximum of 720 

hours during power outages:  time, control programs, editable properties, 
schedules, and trends.  

To conserve battery life, you can set the driver to turn off battery backup after a 
specified number of days and depend on the archive function to restore data 

when the power returns. 
A low battery is indicated by the Battery low LED or a low battery alarm in the 
WebCTRL® application. 

Protection Built-in surge and transient protection for power and communications in 
compliance with EN61000-6-1. 

Incoming power and network connections are protected by non-replaceable 

internal solid-state polyswitches that reset themselves when the condition that 
causes a fault returns to normal.  

The power and network connections are also protected against transient excess 
voltage/surge events lasting no more than 10 msec. 

 CAUTION  To protect against large electrical surges on serial EIA-485 
networks, place a PROT485 at each place wire enters or exits the building. 

BT485 connector You attach a BT485 (not included) to a controller at the beginning and end of a 
network segment to add bias and to terminate a network segment. 

Status indicators LEDs indicate status of communications and low battery status. Seven segment 
display indicates running, error, and power status. 

Environmental operating 
range 

-20 to 140°F (-29 to 60°C), 10–90% relative humidity, non-condensing 

Physical Rugged aluminum cover, removable screw-type terminal blocks 

Overall dimensions Width: 
Height: 

11 5/16 in. (28.7 cm) 
7 1/2 in. (19 cm) 

Mounting dimensions Width: 
Height: 

10 13/16 in. (27.5 cm) 
5 in. (12.7 cm) 

Recommended panel depth 2 3/4 in. (7cm) 

Weight 1.4 lbs (0.64 kg) 

Listed by UL-916 (PAZX), cUL-916 (PAZX7), FCC Part 15-Subpart B-Class A, CE 
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Using expanders 

You can connect expanders to the Carrier® ChillerVu™ to increase the number of inputs and outputs, up to a total 
of 6 expanders connected to the Xnet.  

The Carrier® ChillerVu™ is compatible with the following expanders: 

Automated Logic® 

• MEx016u 

• MEx48u 

• MEx816u 

• MEx88u 

Carrier® 

• MPC Open XPIO48 

• MPC Open XPIO816 

 

For details on individual expanders, see the Automated Logic® expander's Technical Instructions or the Carrier 
MPC Open XP and MPC Open XPIO48/816 Installation and Start-up Guide. 

 

 
 

Safety considerations 

 WARNING  Disconnect electrical power to the Carrier® ChillerVu™ before wiring it. Failure to follow this 
warning could cause electrical shock, personal injury, or damage to the controller. 
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 WARNING  

When you handle the Carrier® ChillerVu™: 
•    Do not contaminate the printed circuit board with fingerprints, moisture, or any foreign material. 

•    Do not touch components or leads.  
•    Handle the board by its edges. 

•    Isolate from high voltage or electrostatic discharge.  
•    Ensure that you are properly grounded. 

 

Screw the Carrier® ChillerVu™ into an enclosed panel using the mounting slots on the cover plate. Leave about 2 
in. (5 cm) on each side of the controller for wiring. See mounting dimensions in Specifications (page 2). 

If using expanders, see Installing an expander (page 7) before mounting the controller. 

 

 
 

Mounting the Carrier® ChillerVu™ 
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 WARNING  Do not apply line voltage (mains voltage) to the controller's ports and terminals. 

 

 CAUTIONS 

• The Carrier® ChillerVu™ is powered by a Class 2 power source. Take appropriate isolation measures when 

mounting it in a control panel where non-Class 2 circuits are present. 

• Carrier controllers can share a power supply as long as you: 

• Maintain the same polarity. 

• Use the power supply only for Carrier controllers. 

 

 
 

To wire for power 

1 Turn off the Carrier® ChillerVu™'s power switch to prevent it from powering up before you can verify the 
correct voltage. 

2 Remove primary power from the 24 Vac transformer. 

3 Pull the screw terminal connector from the controller's power terminals labeled Ground and 24 Vac/26 Vdc. 

4 Connect the transformer wires to the screw terminal connector. 

5 Apply primary power to the transformer. 

6 Measure the voltage at the Carrier® ChillerVu™'s power screw terminal connector to verify that the voltage is 
within the operating range of 21.6 - 26.4 Vac.  

7 Insert the screw terminal connector into the Carrier® ChillerVu™'s power terminals. 

8 Turn on the Carrier® ChillerVu™'s power switch. 

9 Verify that the Power LED is on and the Run LED is blinking. 

 

 
 

Wiring the Carrier® ChillerVu™ for power 
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The Carrier® ChillerVu™ is compatible with the following expanders: 

Automated Logic® 

• MEx016u 

• MEx48u 

• MEx816u 

• MEx88u 

Carrier 

• MPC Open XPIO48 

• MPC Open XPIO816 

 

To install an expander, see the following: 

1 Mount the expander. (page 7) 

2 Wire the expander for power. (page 8) 

3 Address the expander. (page 9) 

4 Wire inputs and outputs. (page 9)     

 

For details on individual expanders, see the Automated Logic® expander's Technical Instructions or the Carrier 
MPC Open XP Installation and Start-up Guide. 

 

 
 

To mount an expander 

 WARNING   

When you handle the expander:  
•    Do not contaminate the printed circuit board with fingerprints, moisture, or any foreign material. 

•    Do not touch components or leads.  
•    Handle the board by its edges. 

•    Isolate from high voltage or electrostatic discharge.  
•    Ensure that you are properly grounded. 

  

Wiring restrictions for connecting the expanders to the Carrier® ChillerVu™ 

• Maximum length: 100 feet (30 meters) 

• 22 or 24 AWG, low-capacitance, twisted, stranded, shielded copper wire 

 

Mount the expanders by the Carrier® ChillerVu™, by screwing the expander into an enclosed panel, using the 
mounting slots on the coverplate. Leave about 2 in. (5 cm) on each side of the controller for wiring.  

Installing an expander to the Carrier® ChillerVu™ 
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To attach expanders 

Do not exceed 100 feet total wire length.  

1 Wire the controller's Xnet Remote Expansion port to the same port on the expander.  

 Connect: 

○ Gnd to Gnd 

○ Xnet- to Xnet- 

○ Xnet+ to Xnet+  

 

NOTE  To use more than one expander, wire their Xnet Remote Expansion ports together in a daisy-chain 
configuration. The Carrier® ChillerVu™ must be the first device on the expander network. 

 

2 You must set the Xnet baud rate to 500 kbps in the WebCTRL® interface on the driver's Xnet page. See To 
set up the driver (page 36). 

3 If the expander network has more than one expander, place the Term jumper in the down position or remove 
it from all expanders except the one at the end of the expander network. The Term jumper must be in the up 
position on the expander at the end of the network.  

 

 
 

To wire the expander for power 

CAUTIONS   

• The expanders are powered by a Class 2 power source. Take appropriate isolation measures when mounting 

it in a control panel where non-Class 2 circuits are present. 

• For the Carrier® ChillerVu™ to recognize an attached expander, you must turn on the expander before you 
turn on the Carrier® ChillerVu™. 

 

1 Verify that the expander's power switch is in the Off position. 

2 Connect the 24 Vac power source to the 24 Vac/26 Vdc and Ground terminals, being sure to maintain proper 
polarity if power is being shared. 

3 Turn on the expander's power switch. 

4 Verify that the expander's Power LED is on and the Run LED is blinking.  
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To set the expander's address 

You must give the expanders an address that is unique on the expander network.  

1 If wired for power, turn off the expander's power and the attached controller's power. 

2 Set the expander's address on the rotary switch.  

EXAMPLE  If the controller’s address is 2, point the arrow on the switch to 2. 

 

 
NOTE  The Carrier® ChillerVu™ can have a maximum of 6 expanders. You MUST address the expanders as 1 
through 6. Higher addresses will not work. 

3 Turn on the expander's power and then turn on the attached controller's power. The controller reads the 
powered expander's address each time you turn on the controller. 

 

  CAUTION  The first time the controller communicates with an expander, it triggers a software download. This 
may occur if the expander(s) are blank (not a normal condition) and in cases where the controller’s driver has 

been updated. During that time, the red Error LED and the green Run LED on the expander(s) flash in sequence. 
This process may take several minutes to complete. Do not disconnect power or communications wiring during 
this download.    

 

 
 

To wire inputs and outputs 

The following applies to the inputs and outputs on the Automated Logic® and Carrier expanders.  

1 Turn off the expander's power. 

2 Connect the input wiring to the screw terminals on the expander. See figure below. 

NOTES   

○ Connect the shield wire to the GND terminal with the ground wire. 

○ For a loop-powered 4-20 mA sensor, wire the sensor's positive terminal to the + terminal on the 
expander's Aux Power Out connector. Wire the sensor's negative terminal to an input's + terminal. 
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3 Set each input's Universal Input Mode Select jumper to indicate the type of input. 

4 Connect digital and analog output wiring to the UO screw terminals on the expander and to the controlled 
device. Connect the ground wire to the UO's Gnd terminal. 

WARNING!  Binary outputs are powered, 24 Vdc channels. Dry contact binary outputs are not supported. Do 
NOT apply 24 Vac to these universal outputs. 
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5 Set each output's jumper to the type of device wired to the output.  

6 For each digital output, turn the output's potentiometer clockwise until it stops (maximum output). 

7 Turn on the expander's power. 
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The Carrier® ChillerVu™ needs two addresses, one for the controller network and one for the Ethernet. 
  

The Carrier® 

ChillerVu™ needs... 

That is 
unique  

on the... 

Notes See... 

A MAC address controller 
network 

You set the MAC address on the controller's 
rotary switches.  

To set the controller 

network MAC address 
(page 13) 

An IP address Ethernet You can use one of the following:  

  • The default IP address that your system 
creates: 

○ IP address = 192.168.168.x where x 
is the controller network MAC address. 

○ Subnet mask  = 255.255.255.0 

To use a default IP 
address (page 13) 

  • A DHCP IP address To use a DHCP IP address 
(page 14) 

  • Assign a custom IP address To use a custom IP 
address (page 14) 

  
NOTES 

• Carefully plan your addressing scheme to avoid duplicating addresses. If third-party devices are integrated 
into the system, make sure your addresses do not conflict with their addresses. 

• The controller network MAC address and IP address are defined in SiteBuilder in the controller's properties 
dialog box. 

• You can address the Carrier® ChillerVu™ before or after you wire it for power. 

 

 

 

 

 

 

 

 

 

 
 

Addressing the Carrier® ChillerVu™ 
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To set the controller network MAC address 

 CAUTIONS   

• The MAC address must be unique on the controller network. 

• If you are using default IP addressing, the MAC address must match the last octet of the Address field in the 

controller's properties dialog box in SiteBuilder. 
  

1 If wired for power, turn off the controller's power.  

NOTE  The controller only reads the rotary switch positions during power up or upon reset. 

2 Use the rotary switches to set the address. Set the Tens (10's) switch to the tens digit of the address, and set 
the Ones (1's) switch to the ones digit. 

EXAMPLE  If the controller’s address is 25, point the arrow on the Tens (10's) switch to 2 and the arrow on 
the Ones (1's) switch to 5. 

10's 1's

1

3

45

2

7
8

9

6

01

3

45

2

7
8

9

6

0

 

 

 
 

To use a default IP address 

 CAUTION  The IP address must be unique on the Ethernet. 

1 If wired for power, turn off the controller's power.  

2 NOTE  The controller only reads the rotary switch positions during power up or upon reset. 

3 Set the IP Addr DIP switch to Assigned (On).  

4 Use the rotary switches to set the Carrier® ChillerVu™'s address. Set the Tens (10's) switch to the tens digit 
of the address, and set the Ones (1's) switch to the ones digit. 

EXAMPLE  If the controller’s address is 25, point the arrow on the Tens (10's) switch to 2 and the arrow on 
the Ones (1's) switch to 5. 

10's 1's

1

3

45

2

7
8

9

6

01

3

45

2

7
8

9

6

0

 

5 Set the +100/0 DIP switch to On to add 100 to x in the IP address.  

EXAMPLE  If you turn on this DIP switch and the controller network MAC address is 25, the IP address is 
192.168.168.125.  

6 Connect Port E1, which is the only port that speaks BACnet over IP.  

 

The default address is an intranet address. Data packets from this address are not routable to the Internet. 
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To obtain an IP address using DHCP 

1 Turn the Carrier® ChillerVu™'s power off. 

2 Check the communications wiring for shorts and grounds. 

3 Set the IP Addr DIP switch to DHCP (Off). 

4 Set Enhanced Access Port DIP switch to Off. 

5 Connect Port E1, which is the only port that speaks BACnet over IP.  

6 Turn the Carrier® ChillerVu™'s power on. The DHCP server assigns an IP address to the Carrier® ChillerVu™. 

7 Set a unique Device Instance number using a touchscreen device, Hyperterminal, or PuTTY (page 26). 

8 Turn the controller's power off, then on again. 

 

 
 

To assign a custom IP address 

1 Obtain the IP address, subnet mask, and default gateway address for the controller from the facility network 
administrator. 

2 Set the Carrier® ChillerVu™'s Enhanced Access DIP switch to ON. 

3 Set the Assigned/DHCP DIP switch to Assigned. 

4 Turn off the controller's power. 

5 Connect a laptop with the WebCTRL® Server to the Carrier® ChillerVu™'s Local Access port. See To 
communicate through the local access port (page 42). 

6 In SiteBuilder, set your Configure > Preferences > Connections tab settings.  
  

Field Value 

Port The computer's port number that the USB cable is connected to. 

NOTE  To find the port number, plug the USB cable into the computer's USB port, 

then select Start > Control Panel > System > Device Manager > Ports (Com & 
LPT). The COM port number is beside Silicon Labs CP210x USB to UART Bridge.  

 

 

Baud Rate 115200 

Data Bits 8 

Parity None 

Stop Bits 1 
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7 On the Network tree, double-click the controller. 

8 On the Address tab, select Specify a custom or DHCP IP Address. 

9 Type the IP Address, Subnet Mask, and Default Gateway Address. 

10 Click Download Address. 

11 When the download is complete, click Module Status in the same dialog box to verify the controller's address. 

12 When finished, set the Carrier® ChillerVu™'s Enhanced Access DIP switch to OFF to restore normal 
functionality to the Local Access port. 

13 Turn on the controller's power. 
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The Carrier® ChillerVu™ communicates using BACnet and/or third-party protocols, and can connect to a variety of 

port types at multiple baud rates. See table below. 
  

Port Protocol  Port type(s) Baud rate(s) 

Ethernet 
Port E1 

BACnet/IP 
BACnet/Ethernet 

Modbus/IP 
Telnet Diagnostics 
 

NOTE  All protocols can 
run simultaneously. 

Ethernet 10 Mbps 
100 Mbps 

BACnet BACnet ARC156 EIA-485 (2-wire) 156 kbps 

S1  CCN EIA-485 (2-wire) 9600 bps 

19.2 kbps 
38.4 kbps 

S2 1 

 

BACnet MS/TP EIA-485 (2-wire) 9600 bps 
19.2 kbps 

38.4 kbps 
76.8 kbps (default) 

Modbus 

 

EIA-232 

EIA-485 (2-wire) 
EIA-485 (4-wire) 

Various 

 

LonWorks Lonworks Explicit  5-pin Port S2 to connect 
LonWorks SLTA-10  

57.6 kbps 

Local Access Enhanced Access Rnet 2  115.2 kbps 

1 Port S2 supports only one protocol and one wire type at a time. 

2  See Wiring devices to the Carrier® ChillerVu™'s Rnet port (page 28). 

 

 

 

 

 

 

 

 

 

 
 

Wiring for communications 
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Ethernet, BACnet MS/TP, ARC156, and CCN wiring specifications 

For... Use... Maximum Length 

Ethernet CAT5e or higher Ethernet cable 328 feet (100 meters) 

BACnet 
MS/TP* 

BACnet 
ARC156*  

22 or 24 AWG, low-capacitance, twisted,  
stranded, shielded copper wire 

2000 feet (610 meters) 

CCN • 3-conductor 

• 18 or 20 AWG stranded tinned copper wire 

• Polyethylene insulation, PVC jacket 

• Shielded with a drain wire 

• Belden wire P#8772 or similar 

NOTE  Must meet the above requirements  

1000 feet (305 meters) 

*For details see the Open Controller Network Wiring Guide.    

 WARNING Do not apply line voltage (mains voltage) to the controller's ports and terminals. 

 
 

To wire to a BACnet/ARC156 network 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Check the communications wiring for shorts and grounds. 

3 Connect the communications wiring to the controller’s screw terminals labeled Net +, Net -, and Shield.  

NOTE  Use the same polarity throughout the network segment. 

4 If the Carrier® ChillerVu™ is at either end of a network segment, connect a BT485 to the Carrier® ChillerVu™. 

5 Turn on the Carrier® ChillerVu™'s power. 

6 Verify communication with the network by viewing a Module Status report in the WebCTRL® interface.  

 
 

Ethernet and BACnet MS/TP wiring specifications 

 

For... Use... Maximum Length 

Ethernet CAT5e or higher Ethernet cable 328 feet (100 meters) 

MS/TP  22 AWG, low-capacitance, twisted, stranded, 
shielded copper wire 

2000 feet (610 meters) per segment 

 WARNING  Do not apply line voltage (mains voltage) to the controller's ports and terminals. 
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To wire to a BACnet MS/TP network 

The Carrier® ChillerVu™ communicates using BACnet on an MS/TP network segment communications at 9600 
bps, 19.2 kbps, 38.4 kbps, or 76.8 kbps.  

Wire the controllers on an MS/TP network segment in a daisy-chain configuration. 

Install a BT485 on the first and last controller on a network segment to add bias and prevent signal distortions 
due to echoing. 

 

  

  
See the MS/TP Networking and Wiring Installation Guide for more details. 

 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Check the communications wiring for shorts and grounds. 

3 Connect the communications wiring to the controller’s screw terminals labeled Net+ and Net- on Port S2. 

NOTE  Use the same polarity throughout the network segment. 

4 Set the Port S2 MS/TP DIP switch to Enable (ON). 

5 If the Carrier® ChillerVu™ is at either end of a network segment, connect a BT485 to the Carrier® ChillerVu™. 

6 Turn on the Carrier® ChillerVu™'s power. 

7 To change the port's baud rate, see To set a port's baud rate using PuTTY (page 26). 

NOTE  Use the same baud rate for all controllers on the network segment. 
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To connect the Carrier® ChillerVu™ to the Ethernet 

Connect an Ethernet cable to the Ethernet port. 
  

NOTE  If your system has controllers on different IP subnets separated by an IP router, you must configure one 

controller on each subnet as a BACnet Broadcast Management Device (BBMD). Do not configure more than one 
BBMD per subnet as this would cause circular routes. To avoid this problem: 

• Let SiteBuilder automatically configure your BBMD tables. (SiteBuilder defines only one controller per IP 
subnet as a BBMD.) 

• Use the BBMD Configuration Tool to make sure that a controller's BBMD table does not contain the IP 
addresses of other controllers on the same IP subnet.  

 

 
 

To wire to a BACnet over Ethernet network 

1  Turn off the power for the Carrier® ChillerVu™ by disconnecting power terminals. 

NOTE  The controller reads the address each time you turn it on. 

2 Connect Port E1, which is the only port that speaks BACnet over Ethernet.   

3 Turn on the power for the Carrier® ChillerVu™ by connecting power terminals. 

4 See Addressing the Carrier® ChillerVu™ (page 12) for details on setting the IP address. You can use PuTTY 
(page 26) or a touchscreen device. 

5 Use a Modstat to find your Ethernet hexadecimal address and enter that in SiteBuilder. 

 

 

 
 

To wire to the BACnet over IP network (DHCP) 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Check the communications wiring for shorts and grounds. 

3 Set the Assigned/DHCP DIP switch to the DHCP position. 

4 Set the +100/0 DIP switch to On to add 100 to x in the IP address.  

EXAMPLE  If you turn on this DIP switch and the MAC address is 25, the IP address is 192.168.168.125.  

NOTE  The DHCP address is an intranet address. Data packets from this address are not routable to the 
Internet. 

5 Verify DIP switch 1 is set to Off.  

6 Connect Port E1, which is the only port that speaks BACnet over IP.  

7 Turn on the Carrier® ChillerVu™'s power. 

8 Set a unique Device Instance number using a touchscreen device or PuTTY (page 26).  
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To wire to a BACnet over IP network (assign a custom IP) 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Using the rotary switches, set the Carrier® ChillerVu™'s address. Set the Tens (10's) switch to the tens digit of 
the address, and set the Ones (1's) switch to the ones digit. 

EXAMPLE  If the controller’s address is 25, point the arrow on the Tens (10's) switch to 2 and the arrow on 
the Ones (1's) switch to 5. 

10's

1's

1

3

45

2

7
8

9

6

0

1

3

45

2

7
8

9

6

0

 

 

3 Obtain the IP address, subnet mask, and default gateway address for the controller from the facility network 
administrator. 

4 Set the Assigned/DHCP DIP switch to the Assigned position.  

5 Set the +100/0 DIP switch to On to add 100 to x in the IP address.  

EXAMPLE  If you turn on this DIP switch and the MAC address is 25, the IP address is 192.168.168.125.  

NOTE  The DHCP address is an intranet address. Data packets from this address are not routable to the 
Internet. 

6 Set the following using a touchscreen device or PuTTY (page 26). 

○ IP address  

○ A unique Device Instance number 

7 Connect Port E1, which is the only port that speaks BACnet over IP.   

Wiring Specifications 

○ 328 feet (100 meters) 

○ Use one of the following CAT5 or higher Ethernet cables: 

▪ A cross-over cable to connect the Carrier® ChillerVu™ directly to the third-party device 

▪ A straight-through cable to connect the Carrier® ChillerVu™ to a hub or switch, and a second 
straight-through cable to connect the hub or switch to the third-party device 

NOTE  Use the same polarity throughout the network segment. 

 

8 Turn on the Carrier® ChillerVu™'s power. 
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To wire to a CCN network 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Check the communications wiring for shorts and grounds. 

3 Verify that the Port S1 485/232 jumper is set to EIA-485 (left side) and the 2/4 jumper to 485-2w (right 
side). 

4 Connect the Carrier® ChillerVu™'s Port S1 to the CCN bus. Use the same polarity throughout the network 
segment. 

Wire this Port S1 terminal  To this CCN device terminal 

Signal Ground (Pin 5) G 

Net- (Pin 2) - 

Net+ (Pin 1) + 

 

NOTE  The CCN Shield should be tied/taped back or daisy chained if the Carrier® ChillerVu™ is not at one 
end of the bus. 

5 Turn on the Carrier® ChillerVu™'s power. 

 

Commission the Carrier® ChillerVu™ using Network Service Tool 

1 Use Network Service Tool V (NST V) to connect the Carrier® ChillerVu™ directly into Port S1, which is 
designated for CCN communications. 

2 Upload the Carrier® ChillerVu™ (Default CCN Address 0, 1). 

 NOTE  After uploading the controller the CCN address should be changed to something other than 0,1. This 

avoids addressing conflicts when uploading Carrier equipment into the i-Vu application. When using NSTV the 
CCN address can be changed by highlighting the Carrier® ChillerVu™ and then clicking on the Display/set 
properties icon. 

3 Access the Service Configuration Table IP_CONF to enter the following configuration options: 

NOTE  A static IP address is required, as DHCP is not supported. 

○ Host IP Address - enter the device manager's IP address, provided by the LAN administrator (allowable 
entries for xxx.xxx.xxx.xxx: xxx is a decimal number between 0 - 255) 

○ Subnet Mask - enter the device manager's IP address, provided by the LAN administrator (allowable 
entries for xxx.xxx.xxx.xxx: xxx is a decimal number between 0 - 255) 

○ Default Gateway - enter the IP Gateway's IP address, provided by the LAN administrator (typically a 
router on the Ethernet LAN).  
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CCN ENET Configuration  

Device Type  -  

○ Select 0 for Gateway if the converter connects the primary CCN Bus (Bus 0) to the Ethernet. Toggle the 
spacebar to select 0.  

○ Select 1 forBridge if the converter connects a secondary CCN Bus to the Ethernet. Toggle the spacebar 

to select 1. The CCN Element number of the CCN Bridge becomes the CCN secondary bus number 
assigned to controllers residing on the network.   

NOTE  You can only have one Gateway per system. 

  

If configured as a Bridge: 

○ CCN/Ethernet Gateway Address - enter the IP address of the i-Vu® device manager that is configured as 

the CCN Ethernet Gateway. This is the same address that was entered in the Host IP address for the CCN 
Gateway. (Entries are allowed for xxx.xxx.xxx.xxx:xxx are decimal numbers between 0 - 255.) 

NOTE  When the device manager is configured as the Gateway, it ignores the CCN/Ethernet Gateway IP 
address. In this case, leave the CCN/Ethernet gateway address at its default setting (0.0.0.0.).  
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You can connect third party protocols after you set up BACnet. The drv_psm for the Carrier® ChillerVu™ allows 
access to the following third party protocols. Additional drivers are not required.  

You can use this combination of protocols or a subset of them:  

BACnet port (ARC156 only) AND Port S1 (CCN only) AND Port S2 (1 of 3 protocols) AND Port E1 (all 4 protocols or 
any combination of them) 

 

Port Protocol(s) 

BACnet BACnet ARC156 

Port S1 CCN 

Port S2 1 of the following 3 protocols - DIP switch selectable (TPI or MS/TP) 

• BACnet MS/TP 

• Modbus RTU 

• LonWorks via SLTA 

Port E1 All or any combination of the following: 

• BACnet/IP 

• BACnet/Ethernet 

• Modbus/IP 

• CCN/IP 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Wiring for third party protocols 
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To wire to Modbus RTU on Port S2 

NOTE  You can use Port S2 for Modbus RTU or Lon SLTA-10, but not at the same time. 

 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Set DIP switch 5 to TPI. 

3 Set jumpers to EIA-485 and Half Duplex. 

4 Connect the communications wiring to Port S2. Connect to Net+, Net-, and Gnd. 

Wiring specifications 

○ A dedicated 24 AWG to 18 AWG twisted pair wire (EIA-485) 

○ 2000 feet (610 meters) for 76.8 kbps 

○ 3000 feet (914.4 meters) for 9600 bps, 19.2 or 38.4 kbps, before needing a Repeater 

○ Devices should be daisy chained and not star wired 

○ If the Carrier® ChillerVu™ is at either end of a network segment, connect a BT485 to the Carrier® 
ChillerVu™ 

NOTE Use the same polarity throughout the network segment.  

 

5 In the WebCTRL® interface, go to Driver Properties > Protocols > Modbus and enter the baud rate. 

6 Turn on the Carrier® ChillerVu™'s power. 

 

 

 
 

To wire to a Modbus over IP network 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Check the communications wiring for shorts and grounds. 

3 Connect Port E1 to the third-party device. 

NOTE  Port E1 will still be capable of BACnet communication. 

Wiring Specifications 

○ 328 feet (100 meters) 

○ Use one of the following CAT5 or higher Ethernet cables: 

▪ A cross-over cable to connect the Carrier® ChillerVu™ directly to the third-party device 

▪ A straight-through cable to connect the Carrier® ChillerVu™ to a hub or switch, and a second 
straight-through cable to connect the hub or switch to the third-party device 

NOTE  Use the same polarity throughout the network segment. 

 

4 Turn on the Carrier® ChillerVu™'s power. 
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To connect to the LonWorks network using the SLTA-10 

1 Turn off the Carrier® ChillerVu™'s power. 

2 Set DIP switch 4 to TPI. 

3 Set the Port S2 jumper to EIA-232. 

4 Connect the communications wiring to Port S2.  

 

 

 

Wire Specifications 

○ 18–28 AWG; twisted pair preferable 

○ 50 feet (15.24 meters) maximum length  

NOTE Do not power the device from the same transformer that powers the Carrier® ChillerVu™. 

 

5 Set the SLTA-10 DIP switches as shown below.  

NOTE  Switches 6 - 8 set the baud rate to 57600 for communication between the controller and the SLTA-10. 

 

 

6 In the WebCTRL® interface, right-click the Carrier® ChillerVu™ in the navigation tree, select Driver 
Properties.> Protocols > LonWorks, and set the baud rate to 57600.  

7  Turn on the Carrier® ChillerVu™'s power. 
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To wire a third-party device 

See the Integration Guide for the third-party device or protocol. 

 

 
 

To set a port's baud rate using PuTTY 

1 Download and install PuTTY from the PuTTY website 
(http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html). 

2 Connect a computer to the Carrier® ChillerVu™'s Local Access port. See To communicate through the local 
access port (page 42). 

3 Set the Carrier® ChillerVu™'s Enhanced Access DIP switch to ON. 

4 Turn the Carrier® ChillerVu™'s power Off, then On. 

5 Start PuTTY. 

6 Under Category > Connection, select Serial. 

7 Under Options controlling local serial lines, enter the following settings: 

 

Field Value 

Serial line to connect 
to 

Replace X with the computer's port number that the USB Link Kit cable is 
connected to.  

NOTE  To find the port number, select Start > Control Panel > System > 

Device Manager > Ports (Com & LPT). The COM port number is beside 
Silicon Labs CP210x USB to UART Bridge.  

 

 

Speed (baud) 115200 

Data Bits 8 

Stop Bits 1 

Parity None 

Flow Control None 

   

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
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8 Click Open. A window similar to the one below appears. 

 

9 Type the number of the baud rate field, then press Enter. 

10 Type the new baud rate, then press Enter. 

11 Type 1, then press Enter to restart the controller. 

12 When finished, set the Carrier® ChillerVu™'s Enhanced Access DIP switch to OFF to restore normal 
functionality to the Local Access port. 

13 Turn the Carrier® ChillerVu™'s power Off, then On. 

 

 
 



 

 

(OPN-PSM-SIM)  CARRIER CORPORATION ©2021   

Installation and Start-up Guide 28 All rights reserved 

 
 

The standard control programs that are included with the Carrier® ChillerVu™ library do not use communicating 
sensors or the Equipment Touch. 

A custom control program could allow you to connect the following to the Rnet port. 

• Up to 15 ZS sensors 

• One Wireless Adapter that communicates with up to 15 wireless sensors 

• One Equipment Touch 

• One TruVu™ ET Display or OptiPoint™ interface 

 

NOTES 

• ZS sensors, a Wireless Adapter, and an Equipment Touch can share the Rnet, but not SPT sensors.  

• The Wireless Adapter, Equipment Touch, or TruVu™ ET Display or OptiPoint™ interface must be powered by 
an external power source.  

 

See the device's Installation and Start-up Guide for complete wiring instructions. 

 

 
 

Wiring devices to the Carrier® ChillerVu™'s  Rnet port 
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To prepare to create your system 

You must create the control program before building your Carrier® ChillerVu™ system.  

 

The Carrier® ChillerVu™ accepts any of the following: 

○ Applications from the psm (plant system manager) equipment SAL library 

NOTE  These applications will not load into any controller except the Carrier® ChillerVu™ controller.  

○ UC applications from the Universal Controller equipment sal library  

○ Air Handler applications from the AHU Builder library  

○ CCN applications from the ivu-6.0 or 6.5-discovery library 

○ User-created EIKON® programs  

NOTE  When creating your program in the EIKON® interface, you must select Control Program > PSM, 
Open (non PIC), or CCN to be able to download the program into the controller.  

 

The EquipmentBuilder or EIKON® application 

1 Use the EquipmentBuilder or EIKON® application to create control program(s) for your Carrier® ChillerVu™.  

2 If applicable, print the Sequence of Operation, which includes the points list. 

NOTE  You can create a points list under Reports in the WebCTRL® application. 

 

 

 

 

 

 

 

 

 

 

 
 

Adding the Carrier® ChillerVu™ into the WebCTRL® system 
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To create your system in SiteBuilder v6.5 

You must complete the following procedures to successfully install your Carrier® ChillerVu™ into the WebCTRL® 
system. Use the Help in the referenced software for detailed descriptions of these procedures. 

 

1 If you have not created your system yet, open SiteBuilder and select File > New. Enter the System Name, 
click Next, and click Next again. 

2 In SiteBuilder, on the Network tree, verify that the BACnet/IP network is correct for your system. 

3 To the BACnet/IP network, right-click and select BACnet Device Router.  

a) Enter the controller's Name. 

b) Change the Device Definition to PSM to add the driver. 

c) If necessary, on the General tab, click Browse, and then select drv_psm_<latest version>.driver. 

d) On the Address tab, check Specify a custom or DHCP IP Address. 

e) Enter the controller's IP address, Subnet Mask, and Default Gateway Address. 

4 If you have a CCN system: 

On the CCN tab: 

1. If the controller will serve as the CCN Gateway, check This device is the CCN Gateway. If this controller 
will be a CCN Ethernet Bridge, fill in the CCN Gateway IP Address of the CCN Gateway.    

2. In the Element Number field, fill in a unique Element Number.  

3. Click OK. 

5 If the Carrier® ChillerVu™ will have an MS/TP network attached, right-click on the PSM icon in the network 
tree and choose Add BACnet Network. In the general tab give the network a name and set the Network 
Number. 

6 Close SiteBuilder. 

7 Open the WebCTRL Server and then the WebCTRL® application. 

8 To set up the CCN network, follow the steps in To scan in and download CCN devices (page 30). 

9 To set up the MS/TP network, follow the steps in To add the control program and graphic in the WebCTRL® 
interface (page 32). 

 

 

 
 

To scan in and download CCN devices 

Set up CCN information 

1 Follow these steps to set the Carrier® ChillerVu™ as the Gateway or Bridge (default).  

NOTE    

a) Set the Carrier® ChillerVu™'s Port S2 DIP switch TPI to CCN (Off) and cycle the controller's power.   

b) Right-click the Carrier® ChillerVu™ and select Driver Properties.  

c) Expand Protocols and select CCN.  
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d) Select the correct baud rate (default is 9600 bps) from drop-down list.  

e) If it is the Gateway, select CCN Gateway for Device Type. If it is a Bridge, select CCN Bridge. 

f) Change the Element number from the default (1). 

g) Continue with the steps below.  

 

Connect to a CCN system 

1 In the WebCTRL® interface, select the system in the navigation tree. 

2 On the Devices page > CCN Setup tab, enter your CCN Gateway IP address and click Connect to Gateway.  

NOTE  If the server has more than 1 NIC, type the IP address the server will use to connect to controllers. 

3 After connecting to the Gateway, select it in the navigation tree.  

4 On the Devices page > CCN Discovery tab, verify that Discover Tables is checked.  

NOTE  The scanning time for discovering tables increases based on the number of devices. You may choose 
to discover tables at a later time for a faster scan. 

5 Enter the Bus and Element ranges that encompass all your devices.  

NOTE  Depending on your number of devices, it could be faster to scan several small ranges.   

6 Click Start Scan. When the process is complete, a message appears showing the number of control programs 
found.  

NOTES 

○ If the scan does not begin, wait a minute and try again. There may be a delay when first starting the 
system. 

○ If an error message appears, click on the message to view an explanation. 

7 Click Download CCN to download the control programs, drivers, and parameters. 

8 In the WebCTRL® navigation tree, right-click the Carrier® ChillerVu™ and select Driver Properties from the 
drop-down list. 

9 Under Driver, expand Protocols. 

10 On the CCN tab, under Broadcast Configuration: 

○ If the Carrier® ChillerVu™ will be the time broadcaster on the CCN network, check Time Broadcast 
Enable. 

○ If there is another CCN device already set as the time broadcaster, check Use CCN Time Sync so the 
Carrier® ChillerVu™ synchronizes its clock with the CCN network. 

11 Click Accept. 

 

TIPS  

•  indicates you need to download the device by clicking Download CCN. 

• Click  to view a log of activity on the Devices page in the current session. Copy to Clipboard lets you copy 
the text to paste it into another application. 

• Status messages are color coded as follows: 

○ Red - reports an error 

○ Blue - requires action 

○ Green - indicates an upload or download is in process 
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To add control programs and graphics in the WebCTRL® interface 

Use the following procedure to add all of the control programs (.equipment files) that you need to run your system. 

 

1 Select the Carrier® ChillerVu™ in the navigation tree. 

2 On the Devices > Manage tab, select the Carrier® ChillerVu™ in the list on the page. 

3 Click the Add Control Program button . A dialog window appears. 

4 Type a Display Name for the control program. 

5 Select the Controller that you are adding the program to. 

NOTE  If you already have the maximum number of control programs for a controller, it will not appear in the 
list.  

6 To add the control program, do the following: 

 

If the control program is...  

In the Control Program drop-down 
list 

1. Select the control program that you generated in 
EquipmentBuilder or Snap. 

2. Click Accept. 

 

Not in the Control Program drop-
down list 

1. Click Add New. 

2. Browse to select the control program. 

3. Click Open. 

4. Click Continue. 

5. Click Close. 

6. Click Accept. 

 

1 To add a graphic, click Add New under Views and browse to your .view file. 

2 Click Continue. When message appears File added successfully, click Close. 

3 Click Close again. 

4 Right-click on the controller in the controller list and select Check Status from the list. The status of the 
controller should say File Mismatch. 

5 Click the Download All Content button.  

6 Configure the controller on the Properties page > Control Program tab. 

7 Check out and commission the equipment. 
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To configure third party protocols in the WebCTRL® interface 

After you download the driver and control program(s) to the Carrier® ChillerVu™, you must configure the protocol 
properties in the WebCTRL® interface. 

Modbus RTU on Port S2 

1 Verify the Port S2 DIP switch (5) TPI is On and the controller's power has been cycled.  

2 On the WebCTRL® Network  tree, click  to the left of your Carrier® ChillerVu™. 

3 Under Driver, expand Protocols > Modbus. 

4 Under Port Configuration, check Enable under Port S2. 

5 Select EIA-485 for Communication Type,  

6 Enter your Baud rate. 

7 Under Protocol Configuration, select the correct option for Is this device a Master?. 

8 Accept all other default settings. 

9 Click Accept. 

Modbus over IP network 

1 Verify the Port S2 DIP switch (5) TPI is On and the controller's power has been cycled.  

2 On the WebCTRL® Network  tree, click  to the left of your Carrier® ChillerVu™. 

3 Under Driver, expand Protocols > Modbus TCP/IP. 

4 Select TCP/IP for Communication Type. 

5 Under Modbus Protocol Configuration: 

○ If your Carrier® ChillerVu™ is a client:  

1. Select Yes for This device is a Client. 

2. Click Accept. 

3. In the navigation tree, under Protocols > Modbus TCP/IP, go to IP Index Table and follow the 
directions at the bottom of the page to fill in the Server IP Addresses. 

○ If your Carrier® ChillerVu™ is a server, select No for This device is a Client. 

6 Click Accept. 

The LonWorks network using the SLTA-10 

1 Verify the Port S2 DIP switch (5) TPI is On and the controller's power has been cycled.  

2 On the WebCTRL® Network  tree, click  to the left of your Carrier® ChillerVu™. 

3 Under Driver, expand Protocols > LonWorks. 

4 Under Port Configuration, select Port S2 for is connected to the LonWorks network, then select SLTA.  

5 Set Baud to 57600. 

NOTE  This is the the baud rate between the LonWorks SLTA-10 and the Carrier® ChillerVu™, not the 
LonWorks network. 

6 Accept all other default settings. 

7 Click Accept. 
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To enable the CCN PIC equipment files to communicate with the Chiller Manager program, you must edit the 

Reference Names in SiteBuilder for the chillers. You must have already completed To scan in and download CCN 
devices to your WebCTRL® system (page 30).  

 

Before proceeding, you must have already: 

• Created your WebCTRL® database 

• Discovered and downloaded the CCN PICs to the Carrier® ChillerVu™ controller 

• Created and added the Chiller Manager control programs to the WebCTRL® database 

• Have WebCTRL Server running 

 

1 From the WebCTRL Server interface, click Launch Concurrent SiteBuilder. 

2 Type your Name and Password. 

3 Click the mode icon to change from View Mode (red) to concurrent Edit Mode (green) and then click Continue. 
 

 

 

NOTES 

○ Any changes you make while SiteBuilder is in Edit Mode are saved immediately. You cannot "close" 
SiteBuilder without saving changes.  

○ In view only mode, WebCTRL Server and field communications run normally. In edit mode, the WebCTRL 
Server is not affected, but field communications are disabled and operators will see question marks on 

WebCTRL® pages instead of live data. After you switch to view mode or close SiteBuilder, field 
communications resume automatically.  

 

 

 

 

 

 

 

 

 

 

Configuring CCN PIC files to communicate with Chiller Manager 
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4 In the Geographic tree, right-click on a chiller and select Properties from the drop-down menu. 

5 In the Properties dialog > General tab, you must change the Reference Name to #chiller_x, where x is 

the chiller number.   

EXAMPLE  For a 3-chiller system, the chiller reference names are: 

○ #chiller_1 

○ #chiller_2 

○ #chiller_3 

6 Click OK. 

7 Repeat steps 4 - 6 for every chiller. 

8 When all chillers are renamed, click the mode icon to change to View Mode. 

9 Close SiteBuilder. 

10 To verify your chiller connections in the WebCTRL® interface, select the Chiller Manager program in the 
navigation tree and go to the Properties > Network Points tab. If you see any errors on the pre-configured 
network points, review your Reference Name edits.    
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After you download the driver and control program(s) to the Carrier® ChillerVu™, you may want to change the 
driver's properties in the WebCTRL® interface to suit your application. 

1 On the WebCTRL® Network  tree, click  to the left of your Carrier® ChillerVu™. 

2 Click  to the left of Driver to see its children. 

3 Make changes as needed on the Properties page for Driver and any of its children. 

 
 

Driver 

On the Driver page, you can change the following properties: 

• Backup battery conservation settings. See table below. 

• Module clock synchronization and failure. See table below. 

• Network Input microblock communication properties. 

 

Backup Battery  

Turn off internal backup 

battery after ___ days to 
conserve battery life (shutoff 
date/time) 

How long backup battery should run after power loss.   

 TIP  Downloading activates the battery backup. To conserve battery life when 
you know the Carrier® ChillerVu™ will be without power for an extended period 
after downloading (for example, during shipment):  

1 Verify the Archive Valid LED is lit, then set this field to 0.  

2 After you install the Carrier® ChillerVu™ and apply power, enter a number 
greater than 0. 

TouchScreen Control  

TouchScreen Schedule Edit 
Enable 

Check this field to allow a user to edit this controller's schedules from an 
Equipment Touch or System Touch Schedules screen. 

NOTE  Schedules edited on an Equipment Touch or System Touch are not 

uploaded to the WebCTRL® application. This could result in the controller 
operating on a schedule that differs from the one you see in the WebCTRL® 
interface. 

Module Clock  

Clock Fail Date and Time Date and time the control program uses when controller's real-time clock is 
invalid. 

 TIP  Use an occupied date and time (such as a Tuesday at 10 a.m.) so the 
equipment does not operate in unoccupied mode if the controller loses power 
during occupancy. 

Time Synch Sensitivity 
(seconds) 

When the controller receives a time sync request, if the difference between the 

controller's time and the time sync's time is greater than this field's value, the 

controller's time is immediately changed. If the difference is less than this field's 
value, the controller's time is slowly adjusted until the time is correct. 

To set up the driver 
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Network Microblocks  

Number of poll retries before 

Network Input Microblocks 
indicate failure 

The maximum number of retries after the initial attempt that a Network 

microblock will attempt to communicate with its target device. If unsuccessful, the 
point will transition to an idle state for 30 seconds before attempting to 
communicate again. Change this field only if directed by Technical Support. 

Periodic rebinding interval If a microblock uses a wildcard in its address, this timer determines how often the 
microblock will attempt to find the nearest instance of its target. For example, if 

an outside air temperature address uses a wildcard, a VAV application will look for 
the outside air temperature on the same network segment or on the nearest 
device containing that object. 

BACnet COV Throttling  

Enable COV Throttling Under normal circumstances, COV Throttling should be enabled to prevent 
excessive network traffic if an object's COV Increment is set too low. See 
EXCEPTION below. 

When enabled, if an object generates excessive COV broadcasts (5 updates in 3 

seconds), the driver automatically throttles the broadcasts to 1 per second. Also, 
if the object's value updates excessively for 30 seconds, an alarm is sent to the 

WebCTRL® application listing all objects that are updating excessively. A Return-
to-normal alarm is sent only after all objects have stopped updating excessively. 

EXCEPTION:  In rare circumstances, such as process control, a subscribing object 

may require COV updates more frequently than once per second. For these 
situations, clear this checkbox, but make sure that your network can support the 

increased traffic. You will also need to disable the Excessive COV alarms under 
the driver's Common Alarms.  

Trend Sampling  

Collect a daily midnight 

sample for all points in this 
controller that are sampling 
on COV 

For values that change infrequently, select to verify at midnight daily that the 
point is still able to communicate trend values. 

 

 

 
 

Device 

On the Device page, you can change the following properties: 

• BACnet device object properties for the Carrier® ChillerVu™ 

• Carrier® ChillerVu™ communication 

 

Configuration NOTE  The three APDU fields refer to all networks over which the Carrier® 
ChillerVu™ communicates. 

Max Masters and Max Info 
Frames 

Apply only if the Carrier® ChillerVu™'s MS/TP network is enabled. 
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Notification Classes 

A BACnet alarm's Notification Class defines:  

• Alarm priority for Alarm, Fault, and Return to Normal states 

• Options for BACnet alarm acknowledgment 

• Where alarms should be sent (recipients) 

Alarms in the WebCTRL® application use Notification Class #1. The WebCTRL® application is automatically a 

recipient of these alarms. 
  

Priorities NOTE  BACnet defines the following Network message priorities for Alarms and 
Events. 

  Priority range Network message priority 

  00–63 Life Safety 

  64–127 Critical Equipment 

  128–191 Urgent 

  192–255 Normal 

Priority of Off-Normal BACnet priority for Alarms. 

Priority of Fault BACnet priority for Fault messages. 

Priority of Normal BACnet priority for Return-to-normal messages. 

Ack Required for Off-Normal, 
Fault, and Normal 

Specifies whether alarms associated with this Notification Class require a BACnet 
Acknowledgment for Off-Normal, Fault, or Normal alarms.  

 TIP  You can require operator acknowledgment for an Alarm or Return-to-

normal message (stored in the WebCTRL® database). In the WebCTRL® interface 
on the Alarm > Enable/Disable tab, change the acknowledgment settings for an 
alarm source or an alarm category.  

Recipient List  

Recipients The first row in this list is from the WebCTRL® application. Do not delete this row. 
Click Add if you want other BACnet devices to receive alarms associated with this 
Notification Class. 

NOTE  Additional entries in this table may be lost after a download. 

Recipient Description Name that appears in the Recipients table. 

Recipient Type Use Address (static binding) for either of the following:  

• Third-party BACnet device recipients that do not support dynamic binding  

• When you want alarms to be broadcast (you must uncheck Issue Confirmed 

Notifications). This use is rare. 

Days and times The days and times during which the recipient will receive alarms. 

Recipient Device Object 
Identifier 

Type the Device Instance from SiteBuilder (or from the network administrator for 
third-party devices) in the # field. 

Process Identifier Change for third-party devices that use a BACnet Process Identifier other than 1. 
The WebCTRL® application processes alarms for any 32-bit Process Identifier. 

Issue Confirmed 
Notifications 

Select to have a device continue sending an alarm message until it receives 
delivery confirmation from the recipient. 

Transitions to Send Uncheck the types of alarms you do not want the recipient to get. 
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Calendars 

Calendars are provided in the driver for BACnet compatibility only. Instead, use the Schedules feature in the 
WebCTRL® interface. 

 

 
 

Common and Specific Alarms 

On these pages, you can enable/disable, change BACnet alarm properties, or set delays for the following BACnet 
alarms: 

Common alarms: Specific alarm: 

• Module Halted 

• All Programs Stopped 

• Duplicate Address 

• Locked I/O 

• Control Program 

• Program Stopped 

• Excessive COV 

• Dead Module Timeout 

• Low Battery Alarm 

 

NOTE  To set up alarm actions for controller generated alarms, see "Setting up alarm actions" in WebCTRL® Help. 
  

Module Generated Alarm  

Description Short message shown on the Alarms page or in an alarm action when this type of 

alarm is generated. 

Events  

Alarm Category and Alarm 
Template 

See "Alarms" in WebCTRL® Help. 

Enable Clear these checkboxes to disable Alarm or Return to normal messages of this 
type from this controller. 

Notification Class Do not change this field. 

 

 
 

Custom Translation Tables 

You can set up a translation table that an analog input will use to translate the raw data from a non-linear sensor 

to the engineering units you want it to output on the wire. In the Network  tree, select Custom Translation 
Table #1, #2, or #3. The Properties page has instructions. For the input to use the translation table, navigate to 

the input in the Geographic  tree, select the Details tab, then set Sensor Type (Scaling Method) to Non-Linear, 

Custom Table #__. 
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BACnet router properties 

On the BACnet router properties page, you can change the following properties: 

• IP address of the router in the controller and the system database 

• BACnet routing settings 

• Color and prime variable caching settings 

 

IP Configuration  

Allow remote management 
of IP configuration 

For future use. 

Enable IP configuration 
changeover 

Select to remotely change the router's IP Address, Subnet Mask, and Default 
Gateway Address.  

Type the new addresses and the UDP Port that your server is using to 
communicate to all controllers. 

In the Changeover timeout field, enter: 

• 0:00 to have the controller use the Next settings as soon as the controller can 

communicate with the Next Default Gateway Address. 

• A specific length of time to have the controller use the Next settings as soon as 

the controller can communicate with the Next Default Gateway Address, or 
when the timeout expires, whichever occurs first. 

See "To remotely change a controller's IP address" in WebCTRL® Help for more 
information on using this feature. 

BACnet Router Options  

Ignore all Reject-Message-to-

Network, Reason=1 
messages 

Clear to delete and rediscover a router if a network's router indicates that the 
network is no longer present (reason=1). 

Select to continue routing messages to a network even if its router indicates that 
the network is no longer present. 

Color/Prime Variable 
Caching 

 

Disable Color Cache Clear (enable) to improve responsiveness in retrieving colors. 

Select (disable): 

• To reduce network traffic to third-party (non-color-supporting) devices 

• If using the Carrier® ChillerVu™ on the controller network, not as a router 

NOTE  Selecting this checkbox also disables dead module alarms. 

Dead Module Timeout After this period (minutes:seconds) of non-response from a controller, the router 
sends an alarm to the server. 
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BACnet firewall 

Requires v6-02 or later driver 

If this IP controller is accessible from the Internet, you can increase security by enabling its BACnet firewall. When 
enabled, this feature prevents the controller from responding to BACnet messages from unidentified sources and 

allows communication only with IP addresses that you define. These can be all private IP addresses and/or a list 
of IP addresses. Follow the instructions in the WebCTRL® interface to set up the BACnet firewall. 

 

 
 

Protocols 

On the Protocols page, you can enable or disable Telnet diagnostics. This allows you to write to a text file the 
communication between the controller and a third party device. This file is used for troubleshooting. 

 

 
 

Xnet 

If the Carrier® ChillerVu™ has MPC Open XPIO or MEx expanders attached, you can change the baud rate and 
communications timeout on the Xnet page.  
  

Xnet Configuration  

Data Rate Set at 500 kbps. 

Comm. Timeout (seconds) If the expander does not receive communication from the controller for this 
amount of time, the expander will reset itself. The range is 15–300 seconds. 
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Using a computer and a USB Link, you can communicate locally with the Carrier® ChillerVu™ to download or to 
troubleshoot. 

  CAUTIONS 

• Maintain polarity when controllers share power.  

• Failure to maintain polarity while using the USB Link on a computer that is grounded via its AC adapter may 

damage the USB Link and the controller. 

• If multiple controllers share power but polarity was not maintained when they were wired, the difference 
between the controller's ground and the computer's AC power ground could damage the USB Link and the 

controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the USB 
Link. Purchase a USB isolator online from a third-party manufacturer. Plug the isolator into your computer's 
USB port, and then plug the USB Link cable into the isolator. 

  

PREREQUISITES 

• For the WebCTRL® application to communicate with the controller, the controller must have been 

downloaded with at least its driver. 

• Laptop with USB port 

• USB Link (Part #USB-L) 

 

Using a USB Link 

1 The USB Link driver is installed with an WebCTRL® v5 or later system. But if needed, you can get the latest 
driver from http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx. Install the 
driver before you connect the USB Link to your computer. 

2 Connect the laptop to the Local Access port of the controller using the USB Link cable(s). 
  

USB Link

Connect to

Local Access port

12 ft

Connect to

USB port

7 3/4 in.

 
  

NOTE  If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link 
cable into the isolator. 

 

 

 

 

 

Communicating through the Local Access port with a USB Link 
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3 Set the controller's Enhanced Access DIP switch. 
  

To communicate in... Set switch to... 

The WebCTRL® application Off 

PuTTY or HyperTerminal On 

SiteBuilder to set a custom IP address On 

 

4 Turn the controller's power off, then on again. 

 
 

To communicate using PuTTY 

You can connect a computer to a controller's Local Access port and use PuTTY, a free open source terminal 
emulation program, to: 

• Set controller properties, such as IP address and network information 

• Retrieve a Modstat 

 

PREREQUISITES 

• A computer with a USB port 

• A USB Link cable   
NOTE  The USB Link driver is installed with an WebCTRL® v5 or later system. But if needed, you can get the 

latest driver from http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx. Install 
the driver before you connect the USB Link to your computer. 

   

 CAUTION   If multiple controllers share power but polarity was not maintained when they were wired, the 

difference between the controller's ground and the computer's AC power ground could damage the USB Link and 
the controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the USB 
Link. Purchase a USB isolator online from a third-party manufacturer. 

 Using PuTTY 

1 Download and install PuTTY from the PuTTY website 
(http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html). 

2 Connect the laptop to the local access port of the controller or ZS sensor using the USB Link cable(s). 
  

USB Link

Connect to

Local Access port

12 ft

Connect to

USB port

7 3/4 in.

 

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html


 

 

(OPN-PSM-SIM)  CARRIER CORPORATION ©2021   

Installation and Start-up Guide 44 All rights reserved 

 
 

  

NOTE  If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link 
cable into the isolator. 

3 To change a router's IP address, subnet mask, or default gateway, set its IP Address DIP switch to Assigned. 

4 Start PuTTY. 

5 Under Category > Connection, select Serial. 

6 Under Options controlling local serial lines, enter the following settings: 
  

Field Value 

Serial line to connect to Replace X with the computer's port number that the USB Link cable 
is connected to.  

NOTE  To find the port number, select Start > Control Panel > 

System > Device Manager > Ports (Com & LPT). The COM port 

number is beside Silicon Labs CP210x USB to UART Bridge.  
 

 

Speed (baud) 115200 

Data Bits 8 

Stop Bits 1 

Parity None 

Flow Control None 

    

7 Click Open. A window similar to the one below appears. 

 

 

8 Do one of the following: 

○ To change a property value: 
a.  Type the number of the property, then press Enter. 
b.  Type the new value, then press Enter. 

○ To take an action, type number of the action, then press Enter. 

9 If you changed a value, type 1, then press Enter to restart the controller. 

10 Close PuTTY. 
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To set up a local access connection in the WebCTRL® interface 

For the WebCTRL® application to communicate with the Local Access port, you must do the following: 

1 On the System Configuration  tree, select Connections. 

2 On the Configure tab, click Add. 

3 From the Type drop-down list, select BACnet/Rnet Local Access Connection. 

4 Optional: Edit the Description. 

5 Type the computer's Port number that the USB cable is connected to. 

NOTE  To find the port number, plug the USB cable into the computer's USB port, then select Start > Control 

Panel > System > Device Manager > Ports (Com & LPT). The COM port number is beside Silicon Labs 
CP210x USB to UART Bridge.  

 

 
  

6 Set the Baud rate to 115200. 

7 Click Accept. 

8 On the View tab, select BACnet/Rnet Connection from the drop-down list. 

9 Click Accept. 

10 On the Configure tab, select BACnet/Rnet Connection, then click Start. 

NOTE  If an error message appears, make sure the COM port you selected is not in use. For example, PuTTY 
may be open and is holding the port open. 

11 On the Network  tree, select the controller that you are connected to. 

12 Click , then select Manual Command. 

13 Type rnet here in the dialog box, then click OK. 

14 On the Properties page, click Module Status. If a Modstat report appears, the WebCTRL® application is 
communicating with the controller. 
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If you have problems mounting, wiring, or addressing the Carrier® ChillerVu™ or the expander, contact Carrier 
Control Systems Support.   

NOTE  To help you troubleshoot, obtain a Module Status (Modstat) from the controller and review the System Error 
and Warning details.  

 

 
 

Controller LED's 

The Module Status LED can display the following error codes. Verify the LED patterns by cycling power to the 
controller and noting the lights and flashes. 
  

Error 
Code... 

  
Indicates... 

 
 Possible solutions 

0 The control program or 
driver has not been 
downloaded. 

Download All Content to the Carrier® ChillerVu™.  

1 A control program error Obtain a Module Status Report (Modstat) and look for error conditions. See 
To get the controller's serial number (page 48) below for instructions on 
obtaining a Modstat. 

If you cannot determine the error from the Modstat, contact Automated 
Logic® Technical Support. 

2 The controller's 
memory is full 

In the WebCTRL® interface, reduce the amount of trend data being stored in 

the controller.  
In SiteBuilder, reduce the amount of control programs. 

3 A setup error Verify: 

• The address has been set on the rotary switches. See Addressing the 

Carrier® ChillerVu™ (page 12). 

• The address is unique on the network 

• DIP switches are set correctly  

4 A system error Obtain a Module Status Report (Modstat) and look for error messages. See 
To get the controller's serial number (page 48) below for instructions on 
obtaining a Modstat. 

If you cannot determine the error from the Modstat, contact Automated 
Logic® Technical Support. 

8 Factory defaults are 
being restored 

 

The number 8 should display only during the short restoring period. If this 
number displays continuously or flashes intermittently with another number, 
try each of the following: 

• Turn the Carrier® ChillerVu™'s power off, then on. 

• Format the Carrier® ChillerVu™. See Restore factory defaults below. 

• Download the controller.  

• Replace the Carrier® ChillerVu™. 

     

Troubleshooting 
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Other LED's show the status of certain functions. 
  

If this LED is on... Status is... 

Power The Carrier® ChillerVu™ has power.. 

Link The controller is connected to the Ethernet. 

LAN The Ethernet port is transmitting or receiving data. 

100 The connection speed is 100 Mbps. If LED is not lit, the connection speed is 10 
Mbps. 

BACnet transmit The Carrier® ChillerVu™ is transmitting data over the BACnet/ARC156 network. 

BACnet receive The Carrier® ChillerVu™ is receiving data over the BACnet/ARC156 network. 

Archive Valid The controller's memory backup is valid. 

Port S1 transmit The Carrier® ChillerVu™ is transmitting data from Port S1. 

Port S1 receive The Carrier® ChillerVu™ is receiving data on Port S1. 

Battery low The battery is low. 

 

 
 

Expander LED's 

The LED's show the status of certain functions. 
  

If this LED is on... Status is... 

Power The Carrier® ChillerVu™ has power. 

Rx The Carrier® ChillerVu™ is receiving data from the network segment 

Tx The Carrier® ChillerVu™ is transmitting data over the network segment 

UO# The binary output is active 

Run Lights based on expander health. See table below 

Error Lights based on expander health. See table below 

  

The Run and Error LED's indicate expander and network status. 
  

If Run LED shows... And Error LED shows... Status is.. 

2 flashes per second Off Normal 

5 flashes per second 2 flashes per second Boot is running or driver is updating 

5 flashes per second On Fatal error. Replace expander or return for repair. 
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To restore factory defaults 

  CAUTION  This erases all archived information and user-configuration settings. You will have to reconfigure 
all custom settings. It is recommended to restore the factory defaults only under the guidance of Carrier Control 
Systems Support. 

 

To erase volatile memory data and restore factory default configuration settings: 

1 Turn off the Carrier® ChillerVu™'s power switch.  

2 Make sure the address switches are not set to 0, 0.  

3 Hold down the controller’s Factory Defaults button while you turn its power on. 

4 Continue to hold down the Factory Defaults button until the controller displays 8 and then the chase pattern, 
then release the button. 

5 Turn on the Carrier® ChillerVu™'s power switch.  

 

 CAUTION  If you have a CCN network and you restore factory defaults, you must download to the Carrier® 

ChillerVu™ from the WebCTRL® application and NOT upload it. Uploading results in losing your CCN 
communication. 

 

 
 

To get the Carrier® ChillerVu™'s serial number 

If you need the Carrier® ChillerVu™'s serial number when troubleshooting, the number is on:  

• a sticker on the back of the main controller board 

• a Module Status report (Modstat) under Core (or Main) board hardware 

 
  

To obtain a modstat in the WebCTRL® interface: 

1 Select the Carrier® ChillerVu™ in the Network  tree.  

2 On the Properties page, click Module Status.  
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To replace the Carrier® ChillerVu™'s battery 

The Carrier® ChillerVu™'s 10-year Lithium CR123A battery retains the following data for a maximum of 720 hours 

during power outages:  time, control programs, editable properties, schedules, and trends.  
To conserve battery life, you can set the driver to turn off battery backup after a specified number of days and 

depend on the archive function to restore data when the power returns. 
A low battery is indicated by the Battery low LED or a low battery alarm in the WebCTRL® application. You can 
purchase replacement batteries from any retailer that sells a CR-123A battery. 

1 Verify that the Carrier® ChillerVu™'s power is on. 

2 Using a small flathead screwdriver, pry up each side of the black battery clip until it is free and you can 
remove it.  

3 Remove the battery from the controller, making note of the battery's polarity. 

4 Insert the new battery into the controller, matching the polarity of the battery you removed. 

5 Push the black clip back onto the battery until you hear both sides click in place. 

6 Download the Carrier® ChillerVu™.  

 

 
 

To take the Carrier® ChillerVu™ out of service 

If needed for troubleshooting or start-up, you can stop communication between the WebCTRL® application and 
the Carrier® ChillerVu™.  

1 On the WebCTRL® Network  tree, select the Carrier® ChillerVu™. 

2 On the Properties page, check Out of Service. 

3 Click Accept. 
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FCC Compliance 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 

15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 

radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to correct the interference at his own expense.  

 CAUTION   Changes or modifications not expressly approved by the responsible party for compliance could 
void the user’s authority to operate the equipment. 

 

 
 

CE Compliance 

 WARNING   This is a Class A product. In a domestic environment, this product may cause radio interference 
in which case the user may be required to take adequate measures. 

 

 

 

Compliance 
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Important changes to this document are listed below. Minor changes such as typographical or formatting errors are not 
listed. 
  

 Date Topic Change description Code* 

1/20/21 To wire a CCN network Added note to step 2 of NSTV about changing the CCN address 

to avoid conflicts 

Specified CCN ENET Configuration Device Type numbers to use. 

C-TS-JN-E 

1/28/19 BACnet firewall Changed "prevents the controller from receiving BACnet 

messages" to "prevents the controller from responding to 

BACnet messages". 

X-PM-KC-O 

Specifications Added surge CAUTION to Protection specification. X-TS-AK-E-CC 

10/26/18 Wiring devices to the Carrier® 

ChillerVu™'s Rnet port 

Reworded, removed SPT/RS sensors, added TruVu™ ET Display 

or OptiPoint™ interface. 

X-D 

Specifications Reworded Rnet port specification and added power supplied by 

Rnet port. 

Reworded Protection specification and added first paragraph.  

X-H-JS-O 

4/27/17 Ethernet, BACnet MS/TP, ARC156, and 

CCN wiring specifications 

Added CCN specs C-TS-JN-E-RD 

2/23/17 Specifications 

Wiring devices to the Carrier® 

ChillerVu™'s Rnet port 

Changed WS sensors to wireless sensors C-D 

2/6/17 BACnet Firewall New topic. C-OC-RD-O 

Wiring devices to the Carrier® 

ChillerVu™'s Rnet port 

Removed device details and clarified lack of support except in 

a custom control program. 

C-AE-BL-O-WB 

Specifications changed details for Rnet port C-D 

Cover 

What is the Carrier® ChillerVu™? 

Changed Carrier® ChillerVu™ to new silkscreen C-D 

7/11/16 

 

To communicate using PuTTY New topic. C-D 

To restore factory defaults Added caution about uploading CCN. C-D 

To create your system in SiteBuilder SiteBuilder v6.5 no longer requires you to enter CCN 

information when it is not a CCN controller. 

C-D 

To use a default IP address 

To use a DHCP IP address 

To wire to the BACnet over IP network 

(DHCP) 

To wire to the BACnet over IP network 

(assign a custom IP) 

Corrected IP Addr DIP switch name from Default to DHCP. C-D 

2/9/16 To attach expanders Added step explaining jumper settings for connecting more 

than one expander. 

X-TS-RD-E-BR 

12/3/15 To connect to LonWorks network using 

the SLTA-10 

Added step to enter the baud rate in Driver Properties C-TR-GG-E-JN 

To wire to Modbus RTU on Port S2 Added step to enter the baud rate in Driver Properties C-TR-GG-E-JN 

Wiring for communications Correction - BACnet/ARC156 added to table. C-D 

  

*  For internal use only 
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